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1.0 Introduction

Blackjack Systems Analyst can be used to develop, test and practice various Play Strategies and corresponding
Bet Strategies (Systems) for playing the game of Blackjack or Spanish 21; and to determine the probability of
winning at the Blackjack table. Set Bet Strategy using formulas to calculate bets to be wagered, or by
establishing preset wagers for progression betting. Automatically set Basic Blackjack Play Strategy for any
combination of typical Game Rules, or set your own variations.

1.1 Application Basics

In Test mode, the simulator will run a series of hands based on Game Rules, Play Strategy and Bet Strategy.
Dealt Hands are grouped into playing Sessions based on reaching a Profit Goal, a Loss Limit, a number of
consecutive Losses, or number of consecutive Gains. Graphs of Balance versus Dealt Hand Number and Balance
versus Session Number are plotted and displayed. Results and statistics for both Dealt Hands and Sessions are
listed to evaluate the effectiveness of the system in producing winning results. Results related to Dealt Hands
and Sessions can be exported to a spreadsheet program for further analysis. To optimize a system, adjust Bet
and Play strategies to result in a gradual increase in balance with minimal variations. In Practice mode, monitor
the simulation as bets are wagered, cards are displayed, decisions are made, and results are shown.

1.2 Using the Application

Navigate through the application and open strategy windows by using the menu and tool-bar buttons at the top
when a simulation is not running.

Menu and Tool-Bar

In the Game Rules window, set any combination of Blackjack rules by which to run the simulation.

In Play Strategy windows, set play decisions for all possible hands against any dealer up card.

In Bet Strategy windows, set bet strategy to use in the simulation. Bets can be Preset or Calculated.

Using the Save dialog box, the current setup of selected rules, play strategy and bet strategy can be saved
within the application. Up to (20) setups can be saved.

Using the Import dialog box, a previously saved setup of game rules, play strategy and bet strategy can be
imported for strategy adjustments and simulation runs.

Options are available to randomize all card shuffles or to repeat card shuffles in all simulation runs.

The User Guide can be accessed at any time, and help regarding a specific topic in any window can be
displayed by clicking next to the topic in question.

2.0 Game Rules

In the Game Rules window, set any combination of Blackjack rules by which to run the simulation. When a
previously saved setup is imported, the game rules are automatically set according to the imported setup.

Game Rules

After all rules have been set, click the Finished button to keep the selections and return to the main window.
If a simulation is in progress, it will be reset.

To discard any changes made to the rules and return to the main window, click the Cancel button. If a
simulation is in progress, it can then be continued from the point where it was stopped.

2.1 Rule Options

Spanish 21 Simulation ( No “10” Cards in all Decks )
Run Spanish 21 Simulations. All four “10” cards in each deck are not
used, so each deck consists of 48 cards.

Decks
The number of card decks shuffled together to simulate the game.
Set from 1 to 8 decks.

Deck Penetration %
The percentage of cards used before a shuffle occurs. Set at
0, 30, 40, 50, 60, 70, or 80 percent. Shuffle occurs after set
penetration is reached and the hand in progress is completed. Zero “0”
Deck Penetration signifies a shuffle after each hand is completed.

Set Player Hand
The first and second card dealt to Player can be set for every hand
simulated to analyze and practice play strategy for specific dealt hands.
If a card is set, a shuffle of all cards occurs after each hand is
completed.

Set Dealer Up Card
The first card dealt to Dealer can be set for every hand simulated to
analyze and practice play strategy for a specific Dealer Up Card. If the
card is set, a shuffle of all cards occurs after each hand is completed.



Ace and 10 in Split Hand Evaluated as Blackjack
When the first two cards in a split hand consist of an Ace and a
10-count card, the hand is evaluated as a Blackjack.

Blackjack Payout
The amount paid to the Player for a Blackjack, set as a ratio to the
amount of the Bet. Select ratio as 3:2, 3:1, 2:1, 1:1, 6:5 or 7:5

Blackjack Tie is a Push
When both Player and Dealer have Blackjack, the result is neither a
Player win nor a loss.

Player Wins Blackjack Tie
When both Player and Dealer have Blackjack, the Player wins.

Player Loses Blackjack Tie
When both Player and Dealer have Blackjack, the Player loses.

Dealer Stands on Soft 17
With one Ace counted as 11 points, Dealer must Stand with
Hand count equal to or greater than 17.

Dealer Draws With Soft 17
With one Ace counted as 11 points, Dealer must must draw a card
with hand count of 17 and Stand with count greater than 17.

BJ vs Player 21 Stand is a Push
When the Dealer has a Blackjack and Player Stand count is 21,
the result is a push.

22 vs Any Player Stand is a Push
When the Dealer hand count is 22, all Player hands left standing result
in a push, except any split hands evaluated as Blackjack.

Player Loses Tie at 17, 18, 19, 20, 21
When Player and Dealer stand on the same count
( 17, 18, 19, 20 and/or 21 ), Player loses the standing Bet.

Insurance on Ace Up Available
When Dealer Up Card is an Ace, Player may bet half the Initial Bet that
the hole card will be a 10 (resulting in a Blackjack). If Dealer has
Blackjack, payout is 2 : 1 on the Insurance Bet.

Dealer Peeks With Ace or 10 Up
Dealer checks for Blackjack before any play, if the up card is Ace or 10.
If Dealer has Blackjack, the Player loses immediately.

Dealer Peeks Only With Ace Up
Dealer checks for Blackjack before any play, only if the up card is an
Ace . If Dealer has Blackjack, the Player loses immediately. If the
Dealer up card is 10 and the face-down card turns out to be an Ace,
the hand is counted as Blackjack and Player can lose all bets placed on
the original hand and any split hands.

Dealer Peeks Only With 10 Up
Dealer checks for Blackjack before any play, only if the up card is a
10 - count . If Dealer has Blackjack, the Player loses immediately. If
the Dealer up card is an Ace and the face-down card turns out to be
a 10 , the hand is counted as Blackjack and Player can lose all bets
placed on the original hand and any split hands.

No Peek ( Lose Only Initial Bets on Dealer Blackjack )
Dealer checks for Blackjack only after Player finishes play. If the Dealer
has Blackjack, Player can lose only the Initial Bet placed on the original
hand and any split hands.

Full No Peek ( Lose All Bets on Dealer Blackjack )
Dealer checks for Blackjack only after Player finishes play. If the Dealer
has Blackjack, Player can lose ALL bets placed on the original hand and
any split hands.

5 - Card Win Pays 3 : 2
When Player stands with (5) cards or more, has not Doubled, and wins
the hand, payout is 3 : 2 on Initial Bet.

6 - Card 20 or Less is Automatic Win
When Player stands on 20 or less with (6) cards or more, player wins
automatically and payout is 1 : 1 on the standing Bet amount.

21 Count is Automatic Win
When Player stands on 21, Player wins automatically and
payout is 1 : 1 on the standing Bet amount.

5 - Card 21 Bonus Pays 3 : 2
When Player stands on 21 with (5) cards and has not Doubled, Player
automatically wins the hand and payout is 3 : 2 on Initial Bet.

6 - Card 21 Bonus Pays 2 : 1
When Player stands on 21 with (6) cards and has not Doubled,
Player automatically wins the hand and payout is 2 : 1 on Initial Bet.

7 - Card 21 Bonus Pays 3 : 1
When Player stands on 21 with (7) cards or more and has not Doubled,
Player automatically wins the hand and payout is 3 : 1 on Initial Bet.

7 - 7 - 7 Bonus Pays 3 : 2
When Player stands on 21 with (3) “7” cards, Player automatically wins
and payout is 3 : 2 on Initial Bet.

6 - 7 - 8 Bonus Pays 3 : 2
When Player stands on 21 with a “6” , “7” and “8”, Player
automatically wins and payout is 3 : 2 on Initial Bet.



Surrender NOT Permitted
Player cannot surrender the hand and forfeit half the Initial Bet
at any time.

Surrender Permitted ( Early )
Player can surrender a hand and forfeit half the Initial Bet before the
Dealer checks for Blackjack.

Surrender Permitted ( Late )
Player can surrender the dealt hand and forfeit half the Initial Bet only
after the Dealer checks for, and does not have Blackjack.

Surrender Permitted ( On Split Hands )
Player can surrender a split hand and forfeit half the Initial Bet.

Surrender Permitted ( On Any Number of Cards )
Player can surrender and forfeit half the Initial Bet after a hand is hit.

Rescue After Double Allowed
Player can surrender (Rescue) a hand and forfeit half the standing Bet
after the Initial Bet is Doubled and one additional card is drawn.

Split Hands NOT Allowed
Player cannot split cards of the same value to make another hand.

1 Split to 2 Hands Allowed
The maximum number of pairs Player is allowed to split is
(1), resulting in (2) split hands.

2 Splits to 3 Hands Allowed
The maximum number of pairs Player is allowed to split is
(2), resulting in (3) split hands.

3 Splits to 4 Hands Allowed
The maximum number of pairs Player is allowed to split is
(3), resulting in (4) split hands.

Bonus Pays on Split Hands
Bonus payments according to Player Count Rules are honored
on both dealt hands and split hands.

Split Aces NOT Allowed
Aces in the Player Dealt Hand cannot be split to make another hand.

Multiple Splits of Aces Allowed
When a pair of Aces are split and another Ace is drawn,
Player can re-split them to make another hand.

Hit on Split Aces Allowed
Player can take multiple hits on split hands created by splitting Aces.

Double NOT Allowed
Player cannot double the Initial Bet on any hand.

Double After Split Allowed
Player can double the Initial Bet and draw only one additional card
on a split hand.

Double On Soft Count NOT Allowed
Player cannot double the Initial Bet and draw only one additional card
on a soft count.

Double On Any Number of Cards
Player can double the Initial Bet and draw only one additional card
after a hand is hit.

Double Only On Hard 10 or 11
Player can double the Initial Bet and draw only one additional card
on a hard count of 10 or 11 only.

Double Only On Hard 9, 10 or 11
Player can double the Initial Bet and draw only one additional card
on a hard count of 9, 10 or 11 only.



3.0 Play Strategy

All combinations of player cards and the dealer’s up card are contained in (4) tables:

Dealt Hand - First 2 Cards
Dealt Hand - After Hit
Split Hand - First 2 Cards (No Further Splits)
Split Hand - After Hit

Play Strategy can be set for all decisions that occur based on the dealer’s up card. As a guide in setting
appropriate strategy, only sensible options are made available for each possible player hand or count in
accordance with logical play. These Strategy Options are indicated for each player hand or count below the
table. For reference, a summary of the set Game Rules is displayed on each strategy window.

To change Play Strategy for a particular hand or count against a specific Dealer Up Card, click the button in
the table at the strategy to be changed until the desired strategy is indicated on the button. Only strategy
options that are available, according to set Game Rules, will appear as a selection on the button. To change
strategy for a particular player hand or count against all dealer up cards, click on an available Strategy
Option below the table. All strategy buttons above the option will be changed accordingly. Unavailable options,
according to set Game Rules, are not enabled.

3.1 Strategy for Dealt Hand - First 2 Cards

The strategy table Play Strategy for First 2 Cards of Dealt Hand and Split Hand (Until All Splits
Formed) includes options for Hit, Stand, Double, Split Pairs, Surrender and Insurance. Strategies are grouped
according to type of player hand:

Hard Count (no Pairs)
Soft Count (one Ace in hand)
Pairs

The initial dealt hand and all split hands are generated according to this strategy table until the permitted
number of split hands are formed. After all split hands are dealt, the strategy table Play Strategy for First 2
Cards of Split Hand (After All Splits Formed) is used. See Section 3.3.

Play Strategy for First 2 Cards of Dealt Hand and Split Hand (Until All Splits Formed)

If Insurance is available according to the set Game Rules, an Insurance Bet can be wagered against a Dealer
Ace Up card for the initial Dealt Hand only. To have the simulation wager an insurance bet for a particular hand
or count, click the button in the Insurance row of the table to display an “I” for that hand or count. Display of
a dash “-“ on a button in the Insurance row indicates that an Insurance Bet will not be wagered for that
particular hand or count. To set the same Insurance strategy for all hands and counts, click the INSURANCE
option below the table. All buttons will display an “I” or a dash “-“. If Insurance is not available per set Game
Rules, the Insurance option is not enabled, and all Insurance buttons will display a dash “-“.

After the Play Strategy has been adjusted, click the Finished button to keep the settings and return to the
main window. If a simulation is in progress, it will be reset.

To discard any adjustments made to the Play Strategy and return to the main window, click the Cancel button.
A simulation in progress can then be continued from the point where it was stopped.



3.2 Strategy for Dealt Hand - After Hit

The strategy table Play Strategy For Non-Split Dealt Hand After Hit includes options For Hit, Stand,
Double, Surrender and Rescue After Double. The strategy applies to the initial non-split dealt hand after the
first and successive hits. Strategies are grouped according to the Player’s hand count:

Hard Count ( no Aces in hand or all Aces counted as 1 point )
Soft Count ( one Ace in hand counted as 1 or 11 points )

Play Strategy for Non-Split Dealt Hand after Hit

After the Play Strategy has been adjusted, click the Finished button to keep the settings and return to the
main window. If a simulation is in progress, it will be reset.

To discard any adjustments made to the Play Strategy and return to the main window, click the Cancel button.
A simulation in progress can then be continued from the point where it was stopped.

3.3 Strategy for Split Hand - First 2 Cards (After All Splits Formed)

The strategy table Play Strategy for First 2 Cards of Split Hand (After All Splits Formed) includes
options for Hit, Stand, Double and Surrender. Strategies are grouped according to the Player’s hand count:

Hard Count ( no Ace in hand )
Soft Count ( at least one Ace in hand )

All split hands (first 2 cards) are generated according to the strategy set for the initial Dealt Hand until the
permitted number of split hands are formed. Therefore, the strategy for first 2 cards of a split hand does not
address pairs. If the game rules are set for no splitting, the strategy windows for a split hand are not accessible.

Play Strategy for First 2 Cards of Split Hand (After All Splits Formed)

After the Play Strategy has been adjusted, click the Finished button to keep the settings and return to the
main window. If a simulation is in progress, it will be reset.

To discard any adjustments made to the Play Strategy and return to the main window, click the Cancel button.
A simulation in progress can then be continued from the point where it was stopped.

3.4 Strategy for Split Hand - After Hit

The strategy table Play Strategy For Split Hand After Hit includes options for Hit, Stand, Double, Surrender
and Rescue After Double. The strategy applies to all split hands after the first hit and successive hits. Strategies
are grouped according to the Player’s hand count:

Hard Count ( no Aces in hand or all Aces counted as 1 point )
Soft Count ( one Ace in hand counted as 1 or 11 points )

Play Strategy for Split Hand after Hit

After the Play Strategy has been adjusted, click the Finished button to keep the settings and return to the
main window. If a simulation is in progress, it will be reset.

To discard any adjustments made to the Play Strategy and return to the main window, click the Cancel button.
A simulation in progress can then be continued from the point where it was stopped.



3.5 Basic Play Strategy

Basic Play Strategy, based on statistical analysis and probabilities, can be loaded into the strategy tables to
account for all combinations of selected rules. To set Basic Play Strategy, click the button Set Basic Strategy
in the Play Strategy drop-down at the top of the main application window or within the File menu. After
Basic Play Strategy is set, all play strategy tables are changed accordingly. The strategies can then be
adjusted by opening each Play Strategy window.

4.0 Bet Strategy

Bet strategies are set up in separate windows. Set the type of bet strategy to use during the simulation under
BET STRATEGY in the control panel on the main window :
Calculated on Result
Wagers are calculated based on Result of the previous hand or the Initial Bet wagered on the previous hand.
Calculated on Balance
Wagers are calculated based on deviation from Session Start Balance.
Preset for Short Runs
Wagers are preset for relatively short runs of Losses and Gains.
Preset on Balance
Wagers are preset based on deviation from Session Start Balance.
Flat Bets During Runs
Wagers are preset for “Flat Betting” until a specified Gain Run Count or Loss Run Count occurs.
Preset for Long Runs
Wagers are preset for relatively long runs of Losses and Gains.

4.1 Preset for Short Runs

Set Initial Bets to be wagered after each loss or gain in a strategy chart. Set the PRIMARY RUN in the
column on the left side of the chart for Loss or Gain. The Secondary Run rows in the chart will be
automatically set to the opposite of what is set for the Primary Run. Set ON RETURN TO PRIMARY RUN to
either Revert to Start Bet or Advance to Next Bet in the Primary Run when the Secondary Run is
interrupted. The RED direction lines and arrows extending from the Secondary Run change accordingly.

Set BANKROLL (100 - 100,000) for the amount to be shown as Balance at the start of the simulation.

Set Start Bet for the Bet wagered on the first hand of the simulation. Following the downward pointing arrows
in the PRIMARY RUN column, set bets for as many as (9) successive hands having the same result (Loss or
Gain). Bets can be set from 1 to 10,000. With the last text box set as “To Start”, the Bet for that hand and the
position in the chart reverts back to the Start Bet. Following the right pointing arrows in the SECONDARY
RUN rows, set Bets for as many as (10) successive hands having the same result (Loss or Gain). With the last
text box set as “To Start”, the Bet for that hand and the position in the chart will revert back to the Start Bet.
If neither Gain nor Loss occurs on a hand (Balance does not change), position in the chart and the Bet
wagered on the next hand remains the same.

Preset Bet Strategy for Short Runs

After the Bet Strategy has been adjusted, click the Finished button to keep the settings and return to the main
window. BET STRATEGY will be set as Preset for Short Runs. If a simulation is in progress, it will be reset. To
discard any adjustments made to the Bet Strategy and return to the main window, click the Cancel button. A
simulation in progress can then be continued from the point where it was stopped.



4.2 Calculated on Result

Separate formulas can be set up for calculating Initial Bets based on the Initial Bet wagered on the previous
Dealt Hand, or based on Net Result of the previous Dealt Hand. Select a Basic Betting System to set up :

User Setup : Configure your own Betting System
D'Alembert: Wager the START BET (one unit) on the first hand. Increase the Bet by one unit

after a Loss. Decrease the Bet by one unit after a Gain.
Oscar's Grind: Wager the START BET (one unit) on the first hand. Increase the Bet by one unit

after a Gain, but to no more than what is needed to reach a profit of one unit.
Wager the START BET after profit of one unit is reached.
Wager the same Bet after any Loss.

Martingale: Wager the START BET on the first hand. Double the Bet after a Loss.
Wager the START BET after any Gain.

Paroli: Wager the START BET on the first hand. Double the Bet after a Gain.
Wager the START BET after any Loss.

Set BANKROLL (100 – 100,000) for the amount to be shown as Balance at the start of the simulation.
Set MINIMUM BET (1 – 10,000) and MAXIMUM BET (1 – 100,000) to establish a range of bets to wager.
Set START BET (1 – 10,000) for the Bet wagered on the first hand of the simulation and at the start of all
sessions. The MINIMUM BET input box is disabled for D’Alembert, Martingale, and Paroli Betting Systems.

Select a formula based on whether the Bet wagered on each hand after a Net Loss and after a Net Gain is to be
determined by a calculation based on the Initial Bet wagered on the previous hand or by the Net Result on the
previous hand. To determine the Bet to be wagered on the next hand, set a factor by which the previous Initial
Bet or Net Result will be multiplied, and an amount to either Add to or Subtract from that result. (The formula
input boxes are enabled only when a “User Setup” Betting System is selected.) Check the appropriate box to
continue to wager the MAXIMUM BET or MINIMUM BET after Net Losses, when the calculated Bet is
outside the min/max range, until a Net Gain occurs. Check the appropriate box to continue to wager the
MAXIMUM BET or MINIMUM BET after Net Gains, when the calculated Bet is outside the min/max range,
until a Net Loss occurs. Otherwise, the Bet to be wagered for the next hand reverts back to the START BET. If
a Loss or a Gain does not occur (Balance does not change), the Bet on the next hand remains the same.

To round the Calculated Bet to a whole number, check the box labeled “Round Up to a Whole Number” or
“Round Down to a Whole Number”. To limit the Calculated Bet so that LOSS LIMIT is not exceeded as
result of a Loss of the Initial Bet wagered on the next hand, check the box labeled “Limit Bet so Loss Limit
is not exceeded on a Loss”. To limit the Calculated Bet so that PROFIT GOAL is not exceeded as result of a
Gain of the Initial Bet wagered on the next hand, check the box labeled “Limit Bet so Profit Goal is not
exceeded on a Gain”.

Calculated Bet Strategy Based on Net Result

Example (See above) :
In the formula to calculate the bet on the next hand after a Loss, the factor by which to
multiply the previous Bet is set at 2 and the “Add” amount is set at 2. In the formula for bet
strategy after a Gain, the factor by which to multiply the Net Gain is set at 1 and the “Subtract”
amount is set at 1. If the Bet wagered on the previous hand is 5 and the result of the hand is a
Loss in Balance, the Bet wagered on the next hand will be (5 x 2) + 2 = 12. If the next hand
results in a Gain, the Bet wagered on the following hand will be (12 x 1) - 1 = 11. But, if the
hand results in a Loss, the formula set up for the next bet following a Loss is utilized, and the
Bet will be (12 x 2) + 2 = 26.

After the Bet Strategy has been adjusted, click the Finished button to keep the settings and return to the main
window. BET STRATEGY will be set as Calculated on Result. If a simulation is in progress, it will be reset. To
discard any adjustments made to the Bet Strategy and return to the main window, click the Cancel button. A
simulation in progress can then be continued from the point where it was stopped.

4.3 Calculated on Balance

Separate formulas can be set up for calculating the Bet when current Bankroll Balance is MORE THAN the
Session Start Balance, and when current Bankroll Balance is LESS THAN the Session Start Balance. To
determine the Bet to be wagered on the next hand, set a factor by which the difference between current
Balance and Session Start Balance is to be multiplied; and an amount to either Add to or Subtract from that
result.

Set BANKROLL (100 – 100,000) for the amount of Balance at the start of the simulation. Set START BET (1
– 10,000) for the Bet wagered on the first hand of all sessions, and when Session Balance equals zero. Set
MINIMUM BET (1 – 10,000) and MAXIMUM BET (1 – 100,000) to establish a range of initial bets to wager.

When the calculated Bet is less than the Minimum Bet, the MINIMUM BET or the START BET is wagered on
the next hand (as selected). If the calculated Bet for the next hand is greater than the MAXIMUM BET, the
START BET is wagered and a new Session begins. If a Loss or a Gain does not occur (Balance does not
change), the Initial Bet on the next hand remains the same.

To round the Calculated Bet to a whole number, check the box labeled “Round Up to a Whole Number” or
“Round Down to a Whole Number”. To limit the Calculated Bet so that LOSS LIMIT is not exceeded as
result of a Loss of the Initial Bet on the next hand, check the box labeled “Limit Bet so Loss Limit is not
exceeded on a Loss”. To limit the Calculated Bet so that PROFIT GOAL is not exceeded as result of a Gain
by the Initial Bet amount on the next hand, check the box labeled “Limit Bet so Profit Goal is not
exceeded on a Gain”.

Calculated Bet Strategy Based on Session Balance

After the Bet Strategy has been adjusted, click the Finished button to keep the settings and return to the main
window. BET STRATEGY will be set as Calculated on Balance. If a simulation is in progress, it will be reset. To
discard any adjustments made to the Bet Strategy and return to the main window, click the Cancel button. A
simulation in progress can then be continued from the point where it was stopped.



4.4 Preset on Balance

Set BANKROLL (100 – 100,000) for the amount to be shown as Balance at the start of the simulation. Set
START BET (1 – 10,000) for the Bet wagered on the first hand of all sessions, and when Session Balance
equals zero. Set Initial Bets based on deviation from Session Start Balance. As many as eight (8) Balance
Ranges can be set up for both NEGATIVE SESSION BALANCE and POSITIVE SESSION BALANCE. Set a
corresponding INITIAL BET (1 – 10,000) for as many Balance Ranges as desired. Within each Balance Range,
the corresponding Initial Bet is wagered until Session Balance is in a different Range. During a simulation, when
Session Balance is in a range where “NEW SESSION” is indicated for INITIAL BET, or when Session Balance is
outside all ranges, a new session begins, and the Start Bet is wagered.

For Negative Session Balance, the option is available to wager the corresponding INITIAL BET in each Balance
Range; or wager the corresponding INITIAL BET until Positive Session Balance is reached or Session Balance
decreases to a lower Range. For Positive Session Balance, the option is available to wager the corresponding
INITIAL BET in each Balance Range; or wager the corresponding INITIAL BET until Negative Session
Balance is reached or Session Balance increases to a higher Range.

Preset Bet Strategy Based on Session Balance

After the Bet Strategy has been adjusted, click the Finished button to keep the settings and return to the main
window. BET STRATEGY will be set as Preset on Balance. If a simulation is in progress, it will be reset. To
discard any adjustments made to the Bet Strategy and return to the main window, click the Cancel button. A
simulation in progress can then be continued from the point where it was stopped.

4.5 Flat Bets During Runs

For both Loss Runs and Gain Runs, set the Flat Bet to wager for all Dealt Hands during the run at up to (13)
Bet Levels, designated A through M. At each Bet Level, set the RUN COUNT to be reached before going to a
different Bet Level; and set the BET LEVEL to go to after the set BET LEVEL RUN COUNT is reached.

Set BANKROLL (100 – 100,000) for the amount to be shown as Balance at the start of the simulation. Set
START BET (1 – 10,000) for the Bet wagered on the first hand of all sessions, and when Session Balance
equals zero. Set the INITIAL BET (1 – 10,000) for each Dealt Hand (Flat Betting) until a specified number of
consecutive Gains or consecutive Losses is encountered, after which the Initial Bet to wager is changed
according to that as set at a different BET LEVEL.

The next Bet after a GAIN that occurs during a LOSS RUN can be set as the START BET, the Initial Bet at BET
LEVEL A in GAIN RUNS, or the Initial Bet at the Same BET LEVEL in GAIN RUNS. The next Bet after a LOSS that
occurs during a GAIN RUN can be set as the START BET, Initial Bet at BET LEVEL A in LOSS RUNS, or Initial Bet
at the Same BET LEVEL in LOSS RUNS. When Net Result of the Dealt Hand is zero, Run Count and Bet Level
remain the same, and the Initial Bet wagered on the next hand will be the same as on the previous hand.

Preset Flat Bet Strategy During Loss and Gain Runs

After the Bet Strategy has been adjusted, click the Finished button to keep the settings and return to the main
window. BET STRATEGY will be set as Flat Bets During Runs. If a simulation is in progress, it will be reset. To
discard any adjustments made to the Bet Strategy and return to the main window, click the Cancel button. A
simulation in progress can then be continued from the point where it was stopped.



4.6 Preset for Long Runs

Wagers are preset for relatively long runs of Losses and Gains. Set the INITIAL BET (1 – 10,000) to be
wagered after each Loss and Gain in a strategy chart. Set BANKROLL (100 – 100,000) as the Balance at the
start of the simulation. Set START BET (1 – 10,000) as the amount to wager on the first hand of all sessions.
Set INITIAL BETS to wager during a RUN OF GAINS. Set INITIAL BETS to wager during a RUN OF
LOSSES.

The wager for the next hand after a Loss that ends a run of Gains can be set as the START BET, the first bet
(BET A) in RUN OF LOSSES, or the Bet a set number of levels back toward the Start Bet in the RUN OF GAINS.
The wager for the next hand after a Gain that ends a run of Losses can be set as the START BET, the first bet
(BET A) in RUN OF GAINS, or the Bet a set number of levels back toward the Start Bet in the RUN OF LOSSES.

Options are available, for both RUN OF GAINS and RUN OF LOSSES, to disable a DOUBLE DOWN (Hit instead)
and/or SPLIT PAIRS (Use Hard Count No Pairs Bet Strategy) in the set Play Strategy on hands where the Initial
Bet is more than a set value. When Net Result of the Dealt Hand is zero (Balance does not change), position in
the chart and the Initial Bet wagered on the next hand will be the same as on the previous hand.

Preset Bet Strategy For Long Runs

After the Bet Strategy has been adjusted, click the Finished button to keep the settings and return to the main
window. BET STRATEGY will be set as Preset for Long Runs. If a simulation is in progress, it will be reset. To
discard any adjustments made to the Bet Strategy and return to the main window, click the Cancel button. A
simulation in progress can then be continued from the point where it was stopped.

5.0 Simulation

Control the simulation in the control box at the lower right corner of the main window. Set MODE to Test or
Practice. Set BET STRATEGY to Calculated on Result, Calculated on Balance, Preset for Short Runs,
Preset on Balance, Flat Bets During Runs, or Preset for Long Runs.

In Test mode, and when the graphs are set to Plot After All Hands Run, number of TOTAL HANDS can be
set from 1 to 1,000,000. Otherwise, the number of TOTAL HANDS to run continuously can be set from 1 to
100,000. When in Practice mode, the time delay between display of each card, decision and result can be
adjusted by moving the PRACTICE SPEED slider. The delay can be set from less than 1 second to
approximately 5 seconds, and can be adjusted before the simulation is started, or during the run.

Hands can be grouped into Sessions (a series of hands that might be played during a period of time). Set
MAXIMUM HANDS (per session), SESSION PROFIT GOAL, SESSION LOSS LIMIT, and MAXIMUM
RUN of LOSSES and GAINS allowable. When outcome of a hand results in either Session Loss Limit reached,
Session Profit Goal reached, or Maximum Loss/Gain Run reached, a new session starts. Cards are then shuffled
and the Bet wagered on the next hand reverts back to the Start Bet (as set in the Bet Strategy being used).

Click the Start button to run a simulation. During a simulation run, the Start button will change to a Continue
button. Click the Stop button to stop (pause) the simulation. Click the Continue button to restart the
simulation from the point where it was stopped. Click the Reset button to clear the graph or cards, and to zero
all results and statistics. Various STOP POINTS can be set to pause the simulation automatically.

Under the Options menu tab, Shuffle Options are available to either randomize all card shuffles, or repeat
card shuffles in all simulation runs. Shuffles can be “Randomized and Not Repeated”, arranging cards in
random order. “Shuffles Randomized” is indicated in the control box. When cards are shuffled, they are
arranged in random order, and that all shuffles that occur in a simulation have cards arranged in a different
random order. This mimics what you would expect to see in a casino.

Alternatively, setting “Different Randomized Shuffles Repeated in Sequence” will result in dissimilar
randomized shuffles being repeated, and occurring in the same order through all simulations run with the same
set SEQUENCE NUMBER. This setting is useful in Test mode. The Sequence Number can be set from 1 to
10000. Any change in strategy, game rules, or session settings could change shuffle points, results and
statistics. Utilize this setting to compare results and statistics of multiple simulations with identical card shuffles
in each run, using various strategies and session settings.

Shuffle Options



5.1 Test Mode

In Test mode, the simulation will run at fast speed, and graphs of Balance versus Dealt Hand Number and
Balance versus Session Number are generated. Either graph can be viewed by clicking the tab labeled
“Graph - Balance / Dealt Hand” or “Graph - Balance / Session”. Speed of the simulation depends on
computer processing speed, and is not adjustable. Check the box labeled “Plot After All Hands Run” to have
the data plotted after all hands have been run, to reduce the run-time for a large number of hands. To develop
a winning Blackjack system, adjust Bet Strategies, Play Strategies and Session settings to result in a gradual
increase in Balance with minimal variations.

When a graph is generated during the simulation, STOP POINTS can be set to pause the simulation if
Session Profit Goal, Session Loss Limit, Minimum Bet or Maximum Bet is reached; when Bankroll is
Depleted or End of Session occurs, or when maximum Loss or Gain Run Count is reached in a session.

Main Application Window – Test Mode

Key Game Statistics, Strategy Results and frequency of Gain Runs and Loss Runs are listed as the
simulation progresses. View these numbers by clicking the appropriate tab. Betting parameters, as set in the
Bet Strategy, are also displayed.

Game Statistics

Strategy Results

Gain / Loss Runs

In Test mode, Dealt Hand and Session results data is stored in separate files. These files can be exported to a
spreadsheet program, where data can be viewed, and various charts and graphs can be generated for further
analysis. The files can be opened with the bundled “Gnumeric” spreadsheet program, or with some other
application (through Windows Explorer), by clicking the Export Results button.

Export Results

Dealt Hand Results data exported includes: Dealt Hand Number, Initial Bet, Total Bet, Gains, Gain Runs,
Losses, Loss Runs, Pushes, Net Result, Balance, and Session Number.

Session Results data exported includes: Session Number, Number of Session Hands, Session Start Balance,
Maximum Session Gain, Maximum Session Loss, Session Result, Session End Balance, and Hand Number.

A Results data-file for a maximum of 100,000 Dealt Hands can be viewed with the bundled spreadsheet
program “Gnumeric”. Data can be viewed and analyzed within Gnumeric, and may be saved as a different
name and file format, for analysis in a different spreadsheet program, if preferred. To open the data-files with
results for a maximum of 1 million Dealt Hands, other spreadsheet programs, like “Excel” and “Kingsoft”,
can be used. These applications are more efficient in opening files having large amounts of data.

With a spreadsheet program, results data can be analyzed by using the “Chart” function, which provides many
useful choices for chart Type, including Bar, Column, and Line. To generate a chart, highlight a column or
specific data to be charted. Then click the Chart Function button to access the chart creation dialog box.

Gnumeric Spreadsheet



5.2 Practice Mode

In Practice mode, the simulation will run at an adjustable speed. All player and dealer cards are displayed for
each hand. A message appears when Dealer checks for Blackjack and when a card shuffle occurs. Amount of
bet wagered, the insurance bet wagered, hand counts, player decisions, and results of the hand are displayed
as the simulation progresses. Key statistics and betting parameters are displayed as the simulation progresses,
as is done in Test mode. (See 5.1 Test Mode)

When the Minimum Bet or the Maximum Bet is wagered, a message is displayed in the text box labeled
“MINIMUM OR MAXIMUM BET WAGERED”. STOP POINTS can be set to pause the simulation if Session
Profit Goal, Session Loss Limit, Minimum Bet or Maximum Bet is reached; when Bankroll is Depleted
or End of Session occurs; or when maximum Loss or Gain Run Count is reached in a session. The
simulation can also be stopped After Each Dealt Hand is displayed.

Main Application Window – Practice Mode

6.0 Save a Setup

To Save the current setup of game rules, play strategy and bet strategy open the Save System Setup dialog
box by clicking the Save button in the tool bar or in the File menu at the top of the main application window.
In the dialog box, the description of the Current Setup is displayed. In the list box, choose a Setup to replace
with the Current Setup. Edit the description in the text box, if desired, then click the Save button. A message
will indicate that the current rules and strategies were saved. Click the OK button. Up to (20) setups can be
saved.

To exit the dialog box before saving a setup, click the Cancel button.

Save System Setup

7.0 Import a Setup

To Import a previously saved setup of game rules, play strategy and bet strategy, open the Import Bet and
Play Setup dialog box by clicking the Import button in the tool bar or in the File menu at the top of the main
application window. In the dialog box, the description of the Current Setup is displayed. In the list box,
choose a Setup to import, then click the Import Button. A message will indicate that the setup was imported.
Click the OK button. Game Rules, play strategy and bet strategy will then be set according to the imported
setup.

To exit the dialog box before importing a setup, click the Cancel button.

Sample setups of game rules, play strategy and bet strategy have been loaded into the application for
importing, further development and testing.

Import System Setup
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